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You have already had an ongoing relationship with Microsoft Word 97. You will now
learn some of the more sophisticated aspects of Word and how you can use it to do
a lot of your work for you.

Word Processors are on 97% of
all computers used in business
offices and educational institu-

tions.
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To get help more quickly than
clicking, you can also hit the Help
key on your keyboard.
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All | Have is Words

Of all the programs that you will use during your high school career, a word
processor is certainly the most valuable. From English essays to biology reports,
words and organizing and formatting them will certainly play a key role for you.

To that end we will be spending a considerable amount of time using and working
with Microsoft Word. This will include using its various formatting and document
templates, along with tables and drawing. We will also using clip art and other
graphics to enhance the work that you create.

Help & Clippit

You already know Clippit and all the fun that you can have with him. With Microsoft
Word, and for that matter any of the Office 97 suite program, you can use Clippit to
get most of the help that you will need to do anything. And use Clippit you will. He
will become your new best friend, for as with any computer program you must
learn how to use the help to effectively use the program.

It is not simply enough to learn how to use Microsoft Word; you must be able to
teach yourself any program, for you may not have the luxury of using the same
program that you might have been trained on. So, learn how to use Clippit, and
any help file that you encounter; it can only help you in the future

Browsing, Searching & Questioning Clippit

While Clippit and the assistant menu is similar to the Windows general help menu,
Clippit does try to act intuitively. Often when you are doing work, Clippit will flash
suggestions to you. He will also alert you when you do something that is ill-
advised (like close a document without having saved it).

The only way that Clippit can do these things is if he is open to help you. So
ensure that you press the Help icon on the right-hand side of the tool bar to have
Clippit open and there to assist you. Any time your want help, simply click on
Clippit to ask him a question.
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Microsoft Word, like any good program, allows you a great deal of control over the
interface and environment in which you work. By allowing you so much control you
can customize and make Word work for you.

View to a Fill

Word lets you see your documents from four different perspectives, each offering
N a different appearance and amount of text and graphic displayed on-screen. To

change the view, choose View from the menu bar (or click on the icons at the

bottom-right of the screen) and then choose one of the following:

—] Normal View; Great when you want to write in a clean screen without worrying about headers,
footers, or page numbers getting in your way.

E Online Layout View: Lets you see the headings you've used to organize your document. The
document headings appear in the left pane of the screen. You can simply click on a heading to

jump to that point in your document.

Outline View: Comes in handy when you don't have the slightest idea what to write but you

best friend. next to Print Preview. want to create.an outl_ine to help orggnize thoughts. While in Outline View, you can organize

it will allov’v you to check to see your thoughts into topics and subtopics.

what your document will look like Page Layout View: Shows you exactly how your document will look when printed, including
if it were printed. headers and footers.

Page Layout View will be your =

Belly up to the Bars

Rather than force you to memorize obscure keystroke combinations or wade
through multiple layers of pull-down menus, Word lets you choose common
commands by clicking buttons stored on a toolbar. The most common toolbars are
the Standard and the Formatting toolbars. (Word actually offers over a dozen
different toolbars, but the Standard and the Formatting toolbars are the main ones
you'll be using). These two toolbars automatically appear when you run Word.
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The Standard Toolbar

The standard toolbar offers access to the program’s most frequently used commands, arranged form left to
right in roughly the order of their frequency of use.

The Formatting Toolbar

The formatting toolbar contains commands to make your text look pretty with different fonts, type sizes, and
typefaces (such as bold, italics, and underline).
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Creating & Customizing a Toolbar

If you have specific commands and actions you wish to use, you can create your own toolbar by choosing
VIEW<TOOLBAR<CUSTOMIZE. You can choose NEW and add the buttons that you wish, and then anytime
you want you can open your toolbar and use your buttons. It is best to avoid modifying any existing toolbars
as this changes it for all users.
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Next only to the Menu Bar and Standard toolbars, the Formatting bar is your next
best friend. Formatting is one of the most advantageous aspects to a word proces-
sor when compared to a typewriter. You can now change the size of the text, itali-
cize, bold, underline, or even shadow your words. If you want you can even change
to a different font. All these formatting changes are done in an effort to improve the
look and the readability of you work.

“ Narmal

= Times Mew Roman = 10 v| B I U ||§

1]
il
e
[11
[11
Bkl
]
1%
U]

= O-4-A-

To format an existing piece of
text, you must select what you
want to change, and then click on
the specific changes you want on
the toolbar.

Readability is key. Try to avoid
using too many different style
fonts in your work, because it can
get difficult to read. Likewise
don't use too small a font size, or
change your font colour and
highlight to the same colour (blue
on blue).

Obviously there is a lot more to
formatting, especially given that
there is a menu devoted to it.
Explore the format menu to see
some of the other things you can
change, including line spacing,
styles, paragraphing and line
breaks.
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Styles « This allows you to quickly choose preformatted styles.

Font « Refers to the overall look of the letters of the currently selected text.
Font Size « The controls the size of the currently selected text.

Bold « Make selected text bold

[talic « Makes selected text italic

Underline « Underlines selected text

Align Left « Makes the light of the selected text line up on the left (with an
uneven right margin

Centre » Centres selected text between the left and right margins

Align Right * Makes the lines of the text line up on the right

Justify « Displays selected text with the left and the right margins perfectly straight;
unlike centring, justifying stretches lines to extend to the margins

Numbering « Adds (or removes) numbers from selected paragraphs.
Bullets « Adds (or removes) bullets from selected paragraphs

Decrease Indent « Moves selected paragraph to the previous tab stop
Increase Indent « Moves selected paragraph to the next tab stop
Outside Border « Draws borders around selected paragraphs and tables
Highlight « Displays selected text against a different colour background

Font Colour « Displays selected text in a different colour
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There are many different ways to change the look of a document, as well as adjust-
ing and fixing the content. In using these ways to doctor the look of you work, you
can create a better impression with your reader.

Use the Tab key to get to those
points where you place your tab
markers.

It used to be common practice to
indent five spaces for each new
paragraph. Nowadays, and with

word processors, three spaces
looks much crisper and cleaner.

There is no longer an excuse for
a misspelled word with the new
underlining in word processors.

Ensure that you do fix and correct

all spelling errors before doing a

final printout.
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The Ruler

The ruler shows the margins and tabs of your document. If you're creating a multi-
column document, the ruler also shows the column placement and the distance
between the columns. By using the ruler, you can make margins wider (or smaller)
and change the indentation of paragraphs.

Tabs
Word provides four different types of tabs that you can set on the ruler:

L Left Tab (looks like an L): Moves text toward the right edge of the page

<L Centre Tab (looks like an upside-down T): Centres text around the tab

-l Right Tab (looks like a backward L): Moves text toward the left edge of the page

<= Decimal Tab (looks like an upside-down T with a dot next to it): Aligns decimal numbers in a column

on the decimal point

To place a tab, click the cursor anywhere in the paragraph that you can to modify
with a tab. Click the Tab Selection button (far left of the ruler), until it displays the
tab that you want to use. Click the ruler where you want to place the tab. Exact
numerical tabs can be set in the FORMAT<TABS menu.

Indents

to help you indent paragraphs, the ruler also has little buttons that you can adjust to
indent entire paragraphs, indent just the first line of each paragraph, or create hanging
indents. Select the paragraph you want to indent, and then click and adjust the ap-
propriate buttons (those little triangles at the left and right sides of the ruler.

Spelling/Grammar/Thesaurus

As you type, Word underlines possible spelling errors in green, and grammar errors
in red. You can check an entire document by choosing the Tools menu and then
spelling and grammar. You can also simply right-click on a highlighted word for a
pop-up menu that will offer suggestions and options. You can also use the Thesaurus
option using TOOLS<LANGUAGES to get suggestions for synonyms (words that
have a similar meaning). You can make each change individually or let Word replace
all instances; but beware that Word will change ALL instances to that suggestions.
(You can often end up with unwanted changes). It is also wise to have Word ignore
names and other capitalized nouns.

Headers and Footers
You use headers and footers for displaying text on multiple pages. Choose
VIEW<HEADER AND FOOTER and Word will let you insert a variety of informa-
tion including titles, dates, page numbers, and even the time (of course you can
enter any other information that you want in a footer or a header.
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You will be using ClipArt quite
extensively. You will also need to
learn how to use photographs
and other images that you will
scan into the computer.
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Multi-column

To give your document a professional look you can use columns. Choose
EDIT<SELECT ALL . Click on the columns button in the Standard Toolbar.
Highlight the number of columns you want by dragging the mouse to the right.

Text Box

A text box is a container for text that you can move and place anywhere. Simply
choose from the Insert menu, Text box, and then draw your box and enter your text.
To move the text box, click on the gray border. If you want to resize it, click on the
handles (the little squares on the edges) and move them how you want them. You
can even wrap text around your text box by selecting the text box your want to
change. Then choose Format, then Text Box. Choose the wrap option you want and
click okay. Even better, you change the direction of the text within your text box, by
selecting the box and then choosing Text Direction from the format menu. This allows
you to rotate the text in various directions. A text box is an obejct and many of the
formatting commands that apply to other objects also apply to text boxes.

Pictures

Graphics are where it's at with documents (as if you hadn't noticed with my stuff).
To add a picture, choose Insert and Picture. From the pop-up menu you can
choose from Clip Art, from File, AutoShape, WordArt, or Charts. Depending on the
option you chose, Word may display a dialogue box or display a picture in a
picture box in your document. You can even wrap text around your picture.

Drop Cap
rop caps create a further picture draw on the page. You can create
D one by selecting the letter, or even paragraph that you want. Word
creates a text box that holds the place of the first letter to create an inter-
esting effect that most of use are familiar with in children’s books.

Footnotes

A footnotes is a form of citing referenced material in your work. By using a foot-
note, you show that information that you are referring to in your work came from
somewhere else to avoid plagiarism.. A superscript number () is put after the text
that is being cited, and it matches to a corresponding number at either the bottom
of the page or at the end of the document with the specific information that shows
where you the information came from.

Tables of Contents/Index

When you create a document that is quite long, you want to provide ways to
organize it so that readers can quickly find the information that they want. You can
do this by creating a table of contents (found at the beginning of a document), and/
or an index (found at the end of the document.
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Sometimes you must re-create the same document over and over again, but with
very few changes. To avoid re-typing information, we use templates and styles to
pre-format the document and then add what we need to it.

Document Templates
Word provides you with many [
options for creating documents that e A T re— 5
are preset for you. These can &
include specific memos, faxes and B
letter, along with other related ===
documents including resumes, press 5
Templates are the bestway 0 relagses, or brochures. To use the )
make sure that several related | imolv ch ==
documents all have the same  (EMPIates, simply choose
look and feel as one another.  FILE<XNEW menu and select the template that works best for your needs.

||||||

You can also create your own new templates with your documents as well. After
you have set up your document, including any styles that you have set, you
choose Save As. When the window pops up, choose Document Template from the
pull-down menu at the bottom of the window. Now when you open your docu-
ment, you will have an untitled version that you can make changes to and modify
from the point that you saved it at.

Choosing a Style Template
e | Think of a style template as a cookie cutter for text. Word defines different mar-
T | gins, fonts, type styles, and font sizes for your text in the style templates. All you
_J e have to do is type the text, and Word can format your text according to the shape
= of the style template. To use one of the Word style templates, make sure that you
=== 4 have a document open (either a blank or an existing one), and then choose
=== FORMAT<STYLE GALLERY. The Style Gallery dialogue appears. Click through
the various templates and click on one of the Preview group (Document,
Example, or Style Samples). Click okay when you find a style template that you
like. After you choose a style template, you can use its styles to make your text
look pretty. Simply move your cursor to the part of the document that you want to
change. Click the Style list box on the Formatting toolbar (it's the box all the way
on the left, showing a style name) to choose a style. Then click on the style that
= you want to use.

You can create your own Style templates as well. When you have created a style
that your like (Arial, 13 pt, bold, centred, double-spaced), you simply select the
~se—====== | textand choose Format'Style and turn your selection into a new style.
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Word is truly a incredible domestic servant, and its ability with tables is quite exten-
sive. Tables let your organize information in rows and columns, which can be useful
for displaying information in an easy-to-read format. Tables let you pull essential
facts and figures out of text so that your readers can see what you're tying to say
very easily and quickly.
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When you're working with a table,
keep the Table Toolbar on your
desktop for quick and easy use.

© Findley 2000

Vocabulary Lesson
Before you get started with tables, you need to know some things about rows and columns,
including the following

° A row displays information horizontally.
. A column displays information vertically.
° A cellis a single box formed by the intersection of a row and a column.

Making a Table

Choose Table'Insert Table. In the dialogue box that appears, choose the number of columns, the
number of rows, and adjust the width of the columns up or down. Once you've made all your
decisions, click on AutoFormat. Choose the table format that you want when the next dialogue box
comes up. The preview window shows you sample of what it will look like. After you select the
format, your table appears. Enter the information that you wish in the spaces available. Remember
that any text you enter can be formatted just like text outside of a table.

Modifying your Tables

After you create a table, you may want to make it bigger or smaller by adding or deleting rows and
columns. To modify the size of cells (or even join them together), add rows (or delete them), add
columns (or delete them), simply highlight what you want to change, add to, or delete, and then
select the Table menu and the appropriate option or use your Table Toolbar.

Table ToolBar

To make changes to line widths, colours, and even the order of information in your tables, the Table
Toolbar is your best bet. It provides you with quick and easy control of the more detailed aspects of
your table. Simply highlight what you wish to change and click the appropriate button.
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Remember kindergarten; remember drawing, painting, and not caring about
whether you coloured in the lines? Word tries to give some of that fun back to you

by allowing you to draw, and even paint in a way, and forgives you every time by
letting you undo and change anything you want.
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Holding down your shift key while
drawing a shape or resizing a
picture, will cause it to maintain
its proper dimensions, giving you
a perfect circle, square, or
properly sized picture or graphic.
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Drawing with the Microsoft Draw Toolbar

You have already used the Microsoft draw toolbar a number of times for various assignments. It
gives you the opportunity draw lines, boxes, and other various shapes, and then change the colour,
line widths, and even the shades.

Shapes & AutoShapes

With shapes (circles, squares, rectangles, ovals) you can satisfy most of
your drawing needs. You can draw out what you want with the appropriate
tool- shape selected. You can then modify the colour and line width. Using
AutoShapes you can draw out more complex forms, including text bubbles,
stars, and even lightning bolts. And, just like with regular shapes you can
modify and change them, or even add a 3-D effect to them. AutoShapes
also allows you to draw out irregular forms that are combinations of curved
and straight lines.

Lines & Arrows

Another important component to drawing, is the use of lines and arrows.
This way you can create labels to your drawings, or create shapes that are
not easily made by using lines to join together to form triangles and other
irregular shapes.

Ordering & Grouping

You can use the pop-up menu under the draw button to organize your
various shapes and forms. Select the item(s) that you wish to modify, and
then use the pop-out menus to change things. You can reorder objects, or
even group them together so that they are connected.

Moving, Rotating, Resizing

Often you will want to not only order and group, but also move, rotate, and
resize objects. Clicking and holding on the handles for any object will allow
you to move it easily. You can rotate an object by clicking on the rotate and
then selecting the object you want to rotate; click on the object handles to
turn it one way or the other.

Despite all the wonderful things that Microsoft Word's Draw Toolbar can do, it is
very limited and does not allow for most creativity. Futhermore, things you create
do not necessarily look the same when copy and pasted to other programs.
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. . While Microsoft's Drawing Toolbar offers some freedom for creation by using its
andepainteting various tools, true versitilty is available when you use Macromedia’s Freehand
- ‘ drawing program. Freehand is one of the most versatile graphics programs for the
computer. At its simplest, Freehand is a vector drawing program, which means it is
NOT dependant on resolution and pixels to create an image; instead mathematical
logarithms are used to make an image as large as you wish WITHOUT a loss of
any details. It allows you to create varied artwork such as drawings, logos, and
illustrations.

Shapes Tools & Lines

Just like in Microsoft's Drawing Toolbar you have access to shapes (circles, squares,
rectangles, ovals, lines and now polygons) that can still satisfy most of your drawing needs.
You can then modify the colour and line width using the inspector window.

Bezigon, Pen Tool, Freehand, Freeform & Trace
Freehand offers you a whole bevy of other tools that allow you to create more intricate
designs and images. By using these tools correctly, you can create complex and beautifully
detailed illustrations that are resolution independent as well.

Combining, Punching, Union, and Intersecting
Freehand also provides you with the ability to take your shapes and designs and connect
them. This goes beyond grouping objects; instead you can turn two objects into one. You
can also take two objects and remove the parts that do not overlap.

Moving, Sizing, Skewing, and Modifying
The above images are samples Another. of the great abilities that Freehand offers is o modify gnd change an object in
of vector based images. Each many different ways. Not only can you move and resize an object, but you can also skew
image is resolution independent and create perspective.

and can be made as large as . . . . .
you want unike the resized  WHile you can create very complex illustrations, those require great skill and lots

versions of the parka below.  Of time. You will begin with creating simple logos and objects.

Unlike the resized versions of the
parka above, the faerie can be
resized as large as we want.
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Photoshop allows us to take images
and combine them together in ways

that are impossible in real life and ) :
lends a realism that is unbelievable. opacity so that you can see-through parts of it.
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Painting with Photoshop

For painting, which involves a free use of colour shapes and forms (and which is
far from forgiving) there is the Adobe Photohop. This program provides a way to
do things that are much more artistic, yet it is not as easy to correct mistakes as
with a drawing program. But, remember that you can Undo you last action if you
make a mistake. Photoshop allows you to work a little more with colour and
design, however, because it is based on pixels and not vectors, images that are
made too large start to look jaggy and boxy.

Paint Brush, Paint Bucket & Airbrush

Photoshop is at its core a painting program. This means all your memories of kindergarten
and painting will come flooding back as you use the variety of colours and brushes to paint
pictures. But remember that just like back then, when you paint over one colour you can't
get it back! (While almost. You can use UNDO in Photoshop just like in other programs.
Furthermore, Photohshop has a HISTORY palette that allows you to UNDO multiple things.
Even moreso, you can use LAYERS to separate your different paintings from one another.)

Selecting, Sizing, Skewing, Modifying & Effects
Another of the great abilities in Photoshop, just like Freehand, is that it can modify and
change an object in many different ways. Not only can you move and resize an object, but
you can also skew and create perspective. Once you have use used Photoshop various
selection tools (the Marquee, the Lasso, and the Magic Wand), you can make changes to
the object with EDIT<TRANFORM and with various FILTERS.

Using Other Images, Layers & Opacity

A large majority of artists use Photoshop as a way to combine various pictures and
illustrations together into a collage. This is achieved by opening each separate photograph/
image and copying them into a new layer. You then modify each image and adjust its

ClipArt & Scanning

You have already used clipart by selecting and placing it from the server. You can also find it in
other placed...you can also do screenshots and copy and paste things. Another way is to scan a
document and then put it into your document. Using an input device called a scanner, you take a
picture of the document you want to capture. A scanner moves a finely focused beam of light in a
systematic pattern over the document you wish to capture, in order to reproduce or sense and
subsequently transmit an image.

You place your document on the bed of the scanner (the glass portion). Then, using the appropri-
ate software, you preview your image. Once you have selected exactly what you want to scan.
Once the image is scanned, you save it, either to disk or your network file. Once you have the
image saved you can place, import, or copy and paste it into your documents.

It is the flexibility offered by using clipart and scanning that further extends the ability of Microsoft's
Drawing Toolbar, Macromedia Freehand, and Adobe Photoshop. The combination of these allows
for incredible images that can convey much more than words can say.
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